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Modernizing Undergraduate Renewable Energy Education:
EU Experience for Jordan
MUREE
DEV4.3-Integration of Remote Labs into VLE
Plugin Administration

1. PLUGIN INSTALLATION

In order to install the developed plugin, viiest must login into the Moodle aan Admin user.
Secondly, at the home pagee must go to theAdministration module, andto select Site
Administration .

Front page settings
Wy profile settings

Site administration

Search

From Site Administration, we must selecthe Plugins subsection andafterwardsthe option of
filnstall pluginso .
aite administration
Motifications
Fegistration
Advanced features
LIsers
Courses
Grades
Badges
Location
Language
Flugins
Install plugins
Flugins overview
Activity modules
Admin tools

Authentication
Rlnrls
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We are going to install the plugin from.zp file. So, at thePlugin type list, we s eActwity t
modul e \endrab)and. drop theip file namedflabcalendar.zip i n tZp package
rectanglescreenFinally, we must select the control of theknowledgementoption.

Install plugin from ZIP file
Plugin type* Activity module (mod) j

Plugin type location ChDocuments and Selfings\Lianos\Mis docomentos\Dessargas\MoodiewWindowsinsialier-
Iatesi-2Asenverimoodie/mod is writable
ZIP package* Choose afile.

labcalendarzip

Acknowledgement* [ | understand that it is my responsibility to have full backups of this site prior to installing additional plugins. |
accept and understand that plugins (especially but not anly those originating in unofficial sources) may contain
security holes, can make the site unavailable, or cause private data leaks or loss

Show mare

Once the plugin is configuredre p u s h tinktall plbgin framahe ZIR file 6 .

Install plugin from the ZIP file

If the plugin meets all the requirements of our Moodle installation pthgin validation page is
shown as follows:

Plugin package validation

Validation passed!

Status  Message Info
Ok Mame of the plugin to be installed
labcalendaz
DK Plugin version
2014111412
oK Required Moodle version
2010031900
QK Full component nsme
med_labealendaz
oK Wirite access check
C:\Documents and BettingsiLlancsiMi=z 4 1% \Moodl eWindows Install ez-latest-27, serverineodl efmed

Cancel In=tall plugin!

Now, we are ready to install the plugin, thus we should clickerinstall plugind b u During n .
the installation of the plugin, the database is chanbleerefore the following page iseportedabout
the need of updating the database.
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Plugins check

Tempus

This page displays plugins that may require your attertion during the upgrade. Highlightedl ftems include new plugins thet are sbout to be installed, updated plugins that
are ahout tn be upgraded and any missing plugins. Adedtionsl plugins are highlighted if there s an available updste for them 1 is recommenced that you check
‘whether there are mare recert versions of pluging avalable and update their source code before certining with this Moodie upgrade

Check for available uptates

Number of plugins requiring your attention: 1

Dispisty the full list of Installed plugins

Plugin name Directory Seurce Current version New version Requires Status
Activity modules

of labcalendar frandflabealendar Additional 2014111412 To be installed

Reload

Upigrade Moodle tatabase now

I n order to continue wit bWpgtadedoodedatabadehat.i on, we
Finally, if thereare not errorgluring the database update, the plugin is successfully installed and we
can start to @ate Laboratory activities. So, just click @entinue button.

Upgrading to new version

mod_labcalendar

SLCCesE

Cortinue

2. REGISTERING EXPERIMENTS

An experiment at a laboratory should havevebsitewhere the experiment takes place, a status
service that reports about the status of the laboratomg a dataesvice sothat the student and
lecturer can retrieve the experiment data.

If it is the first timethat the laboratory is used withMoodle, the laboratory must be registered. In
order to register a laboratgrywe must go to Site Administration>Plugins>Activity
Modules>Laboratories:
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¥ Site administration
£ notifications
- Registration
¥ advanced features
P Users
P Courses
b Grades
} Badges
b Location
b Language
¥ Plugins
£F install plugins
£F Pluging overview
ACHVIDY modules
ﬁ Manage activities
b Assignment

£ Book

& chat

¥ Database

£ Folder

£ Forum

ﬁ Glossary

ﬁ M5 content package
¥ Laboratories

& Lanel

e

At Laboratories Administratigrwe can see the already installed laboratories and experiments:

01 Progranr: Admekaon: FL %

€ 3 1o focaostin

do Jleda & a =

Programar  Enlish (en) ~

u are logged in as Admin Usuario (Log out,

Home » Site ax Plugins » Acthity modules » Laboratories Blocks editng on

NAVIGATION o) Adding a Laboratory  Adding an Experiment
1d Name Institution  City Country  Web Is Mail
Laboratonos ¢ SCO@UNED  Madnd  Span nitp #mercurio scc uned &5 Yes Uanos Tobama  llanos@scs uned es
o) Laboratonos de PSUT PSuT Amman  Jordan  rttpémapec ju edu Mureeiome aspx No Mamoun Dmour  llanos@sce uned es
ADMINISTRATION olo)] Min. Max.
session session Min.
¥ My profie settings duration  duration  pause
. Sus administration 14 Name Laboratory  Webpage (minutes)  (minutes)  slot  Documentation Status service Session data service
Aeolian 15 1 nip152.204.
Bask MindTurbinews:
Experiment
Solar Basic 2 15 ' Weosite
Experiment
m
e 3 Domote Laboratorios 2 15 1 ToDo
~ Plugins House de MUREE
st Experiment (1)
% Py few 4 Solarang ity esujr 2 15 1 To0o
™ Actity modules Aeolian
e activties Latoratory

In the top of t he Addinghadabaratawys buttoathat dllaws ub totadd e nefiv
laboratory. The following forns opened:
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Fi1 Programar: Adminitration: FL. %
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€ ol Tocahost i x 3 ¢ |8 FAaa ¥ a =

Programar  E > | jed In 35 Agmin Usuario (Log out)

Moodle

Hame - Site aoministration » Plugins - Activity modules - Labaratories Blocks editing on

name*

Harne
institution*
My home:
Site pages
My profiie city
My courses
Country

Website*
responsible
Emaill of the responsible”

My profile settings

Can the experiments be used [
concurrently?

Site administration
Motification
Registratior
Advanced features
Courses
Grades
Badges Ther
Location

& are required fields in this form marked *

Language

The parameters of a laboratory #ne following

fNameof the | aboratory. For example AUNED Labso.
i Institutiont hat hosts the | aboratory. I n our case is
1 City where the laboratory isom. This parameter is optional. In our cas#edrid.

9 Country where the laboratory fsom. This parameter is optional. In our case is Spain.

1 Website of the institution of the laboratory. In our caséiip://mercurio.scc.uned.es

1 Responsibleis the name ofhe technical responsible of the laboratory and highil. If an error
happensthe plugin is going to contact this responsible by means of an email. In our example, the
responsible is Llanos Tobarra and her emdiaisos@scc.uned.es

1 If the laboratory allows two or more experiments at the same time the laboratory is concurrent. But

if the laboratory only allows one experiment per time it is not concuriat.assume that each
experiment can be used by ynbne student at the same time. Our experiments use different
components of the laboratory so they are concurrent.

Once the formis filledw e  p Ad chgo fhathe laboratory is added to Moodle.

If a laboratoryhasbeen already registergdie can add a new experiment directly to that laboratory.

From the | aboratory administration, Addirg art an adoc
Experimento .

ES Laborataries Blocks editing an

Adding = Laboratory Adding an Experiment Sessiong

Laboratories

Id Name Institution City Country  Web Is concurrent? Resp ibl Resp ible Mail

1 Laboratorios de MUREE SCC@UNED Madrid Spain http://mercurio.scc.uned.es Yes Llanos Toharra llanos@sce . uned.es

2 Laboratoriog de PSUT PSUT Amman  Jordan http:/mapec ju.edu jo/Muree/Home. aspx Mo Mamoun Dmour llanosgsce . uned.es

EFEvnarimantc

The Experiment form is opened:
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Laboratory* Laborstorios de MUREE j

Tempus

name*
Experiment webpage *
Minimum session duration
{minutes)*

Maximum session duration
{minutes)*

Minimum gap duration (minutes)=*
URL for the Status Web Service
URL for the data Web Service

documentation

m s

The experiment parameters are the following:

1 Thelaboratory which must be previously registered, where the experiment takes place.

1 Experiment webpage. Each experiment hasviébsite For example, UNED Lego Windturbine
experimenhasthe webpagéttp://62.204.199.219:8080/web3/index.html

9 Minimum session duration in minutes. Lecturers can configure the experiment sessions to fit into
their needs. But there must be a minimum and a maximum of the session duration. This minimum
must take into accounlie time that takes the upload of the experiment webpage. In our example the
minimum is 1 minute.

1 Maximum session duration in minutes. In our example the maximum is 15 minutes.

1 Minimum gap in minutes. Between two sessions the laboratory must need dipeuseorder to

recover the sensor values or other circumstances. Here that gap is configured. In our example this
value is 1 minute.

9 URL for the status service. Each laboratory should have a status service. This service reports about
errors on the laboratory or if the laboratory is already in ushik parameter is optional but it is
hightly recommended. In our example the status cervi is at
http://62.204.199.219:8080/WindTurbineWS3/status

1 URL for the data service. This service retrieves the session data into a data file for the student and
the lecturer. In our case, wese the data servidetp://62.204.199.229:8080/solar/log/1234.csv

9 Documentation contains information for the experiment. In our case we redirect the student to the
laboratory docmentation at httf\mercurio.scc.uned.es
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After this step the experiment is available for lecturers.
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3. LOST SESSIONS

An activity of experiment can be deleted from the course by a lecturer. But, maybe later on, it is
necessary recover some session datat Ale sessi ons can be found at
Laboratory Administrator.

Moodle
Home » Site administration » Plugins » Actiity modules » Labaratories Blocks editing on
Bac
My borme Experiments
Site pages
My pr Student Sessd
(e Id Course (id) Student (name)  Laboratary Experiment Activity  Init date Expired date  End date Status  Priarity file
Admin Usuario Laboratorios de Domotic House Task (1) 2012015 200172015 2001205 cancelled 1
(adimin) MUREE (1) Experiment (3) 0024 00:29 00:30
ook . . ‘ .
Admin Usuana fask (1) 190172015 190172015 19012015 time_out 1 Download
adman 1532 16:37 1636 1
3 2 Tazk (1) 13012015 190172015 12012015 pending 1
1628 1831 16832
My profile settings
- 4 k(1) 19012015 190172015 19012015 finished
e 1538 1543 1544
o
Re 5 2 3 Jonh Doa Task (1) 19012015 190172015 190125 runnang 1
e e (estudiants) 1538 16:43 1544
Users.
Con
Grades

4. ACTIVITY CREATION

Once the plugin is installed in the platform and the experiments and laboratories are registered,
lecturers can add experiments at tloeiarses.

In order to create an activity using a laboratory, first a lecturer must go to the course main page.
There, she/he must activate the course edition by thelfutffon r n ed:i ti ng ono

surso Prueba

Home » Mycourses » Miscclanea » Prusta Turn editing on

Then, at the selected topic he/she should seléctd d  a ity oraresduicerlinko .

Topic 2

Al an activity or resource

A dialog is shown with the list of available resources or activities at the Moodle. Lecturer should
sel babofat oran d | @udadatom



Add an activity or resource (S
=
o Assignment Use the labcalendar module for scheduling the
activities with rermote laboratories.
o ! Chat
& Chaoice
4 =

== Database

s \-{;? External Tool
=l
L& lﬂ,:] Forum
Glossary

Labaratary Plugin

[l [

Lesson
W ouiz

B scorm package
allll survey

% Wik

© B workshop

O O O O

RESOURCES b
L& Book
< | ] File
o [ Foicer <
Add Cancel

Then the activity form is shown. Lecturer should fill this form in orderéate the activity:

of Adding a new Laboratory Plugin to Topic 2¢

~ General

Laboratory ame* (2)

Description =

Display description on course page | |

@

~ Experiment configuration
Laboratory™* Laboratorios de MUREE : Aeolizn Basic Experiment j

The period of the task starts = | 19 j Jenuary j 2015 j 15 j o jtl

The period of the task ends * | 13 j Jr— j 2015 j 15 j o jl‘j

Duration of the experiment session 5
(minutes)*

Duration of the timeslot between 1
two experiment sessions*

Humber of allowed sessions per 1
student

» Common module settings
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The parameters are:

1 The name of the activity. This is the name that is shown at the course.

1 An optional description of the activity.

9 Laboratory is a list where the registered experiments are shown.

1 The period of the task when theigity is going to be available for the students.

1 When the task ends. An activity with an experiment can be created for a month.

1 The duration of a session.

1 The duration of the gap between two sessions.

1 The number of sessions allowed per student. Thieismximum number of sessions that a student
can book with the system.

After filling this forSav® .t Hlehel eaccttudrvdrt ys hmpwpledr sl

page:

Tempus

Topic 2

OF activity 1 Edt ~
Acdd an activity of resource
Once, lecturer can switch off the edition of the course and the activégdy for the students.
Topic 2
OF activty 1

5. MANAGE THE SESSIONS
If a lecturer has successfully created an activity of experiment, when he/she clicks on the activity, the
activity looks like this:

Activity 1
Home
o Laboratory
Sie pages
My profie Lebsoratory name: Labaratorios de MUREE
Currert course Lanoratary insttutian: SCCERUNED
Frusha i
Partcipants Lekaratary responsiale: Lianos Tobarra
Bedges Experiment name: Aeolian Basic Experimert
General Experimert documentation: Webste
Topic 1
T2 Experiment current status: {"Status"["0K" /NKT","8599" "o Error","edle’ "1 81011201 5 15:28.:50°T1
opic
Topic 3 Server fime: 19101 2015 1534
OF Activity 1
LTy Pick up & day
Topic 4
Topic £ enero 2015
Topic & . .
Lu Ma Mi Ju Vi Sa Do
Topic 7
Topic 8
Topic 9
Topic 10
by caurses
9 0 2 2 28 M B
% 21 28 2
Laboratary Administration
Eclt settings
Locally assigned roles
Permissions Book
Check permissions
Fiters
tezn Sessions
Gourse adiministration
Search
Switch role to. wer 7] [—

My profile seftings
Mo sessions

Site acministration
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This view is a bit di f fer ent infoonation related with thee d e nt 0 ¢
laboratory and the experiment:

1 The name of the laboratory, its institution and its responsible. If the lecturer clicks on the
responsible name he/she can send an email to the responsible.

1 The experiment name, its documentatmal its status reported by the status service.

9 The server time.

Activity 1

Laboratory

Laboratory name: Laboratarios de MUREE

Laboratory institution: SCCELUNED

Laboratory responsible; Llanos Tobarra

Experiment name: Aeolian Basic Experiment

Experiment documentation: YWehsite

Experiment current status: {"Status":["Ok" "R&T" "8627" "Ma Error”,"lddle" "19/01,/2015 15:536:35" |1
Server time: 19/01/2015 15:47

Afterwards the calendar is shown. The lecturer can book a session of the experiment like a student.
This process is explained at the student section but the procedure is the same.

Pick up a day This is the availaive scheduler
epernZlild Start at End at Status
lu Ma Mi Ju Vi Sa Do r 1901715 1538 36 191415 15:43:36 @
r 1901715 15:44:57 19001415 15:49:37 o
r 1901715 15:50:38 19001415 15:55:38 @
- 1901715 15:56:39 19001415 16:01:39 ®
L R I 19/01/15 16:02:40 19/01/15 18:07:40 .
% | &7 2| D r 19/01/15 16:09:41 191A5 16:13:41 @
- 1901715 16:14.42 1901415 16:19:42 ®
r 1901715 16:20:43 10001415 16:25:43 ®
r 190115 16:26:44 101415 16:31:44 o
r 1901715 16:32:45 191415 16:37-45 @
Mext Last Fage: ! Go Rows; | 10 j

Boak

Finally there is a table of the sessions of the activity. Lecturers can see all the sessions of the activity,
its scheduled slot, its current status and the associated session file.

10
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Sessions
Search

User j Search

Session id User Start at End at Status Session data Cancel

1 Admin Usuario (admin) 20/01/72015 00:24 20/01/72015 00:29 Cancelled Mo data

2 Adrain Usuario (admin) 190172015 15:32 190172015 19:37 Tirne out Download data

3 Admin Usuario (admin) 190172015 16:26 190172015 16:31 Pending Mo data Cancel
4 Adrain Usuario (admin) 190172015 15:39 190172015 15:43 Finished Download data

a Jonh Doe (estudiante) 190172015 15:39 190172015 15:43 Mo data

5 Jonh Doe (estudiante) 190172015 16:14 19012015 16:19 Fending Mo data Cancel

A session can have the following status:

1 Pending, the session has been leablty a student and it is pending to occur.

1 Running, the session is active in this moment andifiee that habookedthe session is using the
laboratory.

1 Finished, means that theser hasused the laboratory during the session but he/she has left the
experiment before the session expires.

1 Finished (time_out), means that the user has used the laboratory during the session until the session
has end.

1 Unused, means that the user has not enter to the session during its period of time.

A user can cancelledsibwn booked sessions. After cancelling its session, the plugin sends an internal
message and an email reporting about this fact.

But in addition, a lecturer cazancelthe session of a student. In that case, the lecturer should click on
fiC a n cbattad Then the cancellation form is shown and the lecturer must fill it.

A session of a student is geing to be cancelled. An email is sent to repeort about the causes of the cancellation. Please, fill the following form.

Cause* Technical Problems j

Cause description*

Cancel

There are requirad fields in this farm marked *

The student receives an internal message and an email reporting the session cancellation:

Cancellation of a booked session: Technical Problems Reciidos X &8
Admin Usuario <moodle mercurio@gmail.com> 1549 (hace 0 minutos) - -
para mi =
Your experiment session on Monday, 19 January 2015, 4:14 PM with the experiment Domotic House Experiment have been cancalled by lecturer Admin Usuario. His/he reasons are the following: Admin Usuario

And the cancelled session does not appear in the session list.

11
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There is search form decturer can find relevant session by user name or by its status.
6. ACTIVITY EDITION
Once an activity with an experiment is created, it can be edited. The only parameters that can be

modified are the number of sessions and the end of the activity.
First, lecturer must turn editing ohen, the Edit menu is active and he/she can choose Edit settings

Topic 2

OF Activity 1 Edit~

Ilowe rinht

The activity form is showed:

oY Updating Laboratory Plugin in Topic 2
Expand all
General

Laboratory ame Auctivity 1

Description

Display description on course page [

Experiment configuration

The period of the task ends = | 15 v| February || 2m1s = s =] oo 7]

Humber of allowed sessions per | 5
student

Common module settings

Cancel

Then, the lecturer can change the end date of the activity and the number of sessions allowed to a
studentlf a lecturer redoes the duration of an activity and there are booked sessions that become out
of the duration of the activity due to this change, the plugin sends an email and an internal message to
the affected students.

f The lecturerdmin Usuario has modified the duration of the
experiment Task. A5 a consSequence, Your session Tuesday, 20 January
2015, 12:24 &0 have been cancelled.

Message

The sessions that are cancelledhBse circumstancese represented as cancelled in their status.

12
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Sessions

Search
User j Search
Session id User Start at End at Status Session data Cancel
1 Acdmin Usuatio (aciming 2000102015 00:24 2000172015 00:29 Cancelled Mo dsta

1. BOOK A SESSION

Before a student can perform an experiment he/she must book a session in advance. So, first he/she
mustclick on the activity at the cours#.the activity has not starteget, the following message will

appear:

FPrueha Topic 2 Activity 1

Activity inactive

The period of the experiment has not started yet. It will start the Tuesday, 20 January 2015, 5:30 P

If the activity has finished already, the following message will appear:
Topic 4 Activity 2

Activity inactive

The period of the experiment has already finished

If the activity is active, thetudent getthe following view:

13
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» Toplc 6
» Topic 7
» Topic &
» Topic 8
» Toplc 10

» My coursns

In the top of the view, the student is reported about some parametdrs exgeriment: session

Miscelanea - Prusba

Topic 4+ Activity 3

Activity 3

Laboratory

9w w2
% 21 2

duration, number of sessions, experiment documentation and the server time.

Afterwards, a calendar is shown. The student could select a day for the session. The available days are

highlighted in black.

Activity 3

Laboratory

Experiment name: Aeolian Basic Experiment

Experiment documentation: YWebsite

Fumber of allowed sessions per student: 5

Dwration of the experiment session (minutes): 5

Server time: 1901,/2015 17:39

Pick up a day

Lu Ma Mi Ju

19 20 21 22
26 27 28 29

enero 2015

Do

25

o I T o e R B B B

Book

14

Start at
19/014115 17:35.56

1901115 1744 57
1901115 17:50.58
1901415 17:56:58
1901415 18:03.00
1901415 18:09:01
1901415 18:15:02
1901415 18:21.03
1901115 18:27:04

1901415 18:33:.08

Mext Last

This s the available scheduler

End at
12/01/15 17:43.56

190115 17:49.57
120115 17 :55:58
120115 13:01:59
120115 13:05:00
180115 18:14:01
1201415 18:20:02
120115 18:26:03
120115 18:32:04

12/01/15 18:38:05

Page: | Go

Rowys:

1

o
w
=8
=
&

L
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Once the student selectslay, the scheduler of that day is shown. The free sessions have a green dot
next to its timetable. Those which have a red dot are already boblstddent can select a session
click on the selection checkbox and clicking in theé o dutton.

Your selection is 1901715 18:21:03 : 19/01A15 18:26:03

Cancel QK

The plugn checks if the student selection is correct, showing a modal dialog. If the student clicks on
Afoko then the session is booked.

Your session is booked Monday, 19 January 2015, 5:44 P -
Monday, 19 January 2015, 5:49 P

o |

And the selectedséson appears at the session |ist as fAPen
Sessions
Session id User Start at End at Status Session data Cancel
g Jonh Doe (estudiante) 19/01/2015 17:44 19/01/2015 17:49 Time out Download data
10 Jonh Doe (estudiante) 19/01/2015 18:21 19/01/2015 18:26 Pending Mo data Eaned
If student wants to delete a booked session which staeis i Pendi ngo, he/ she onl
cancel button. Only fAPendingd sessions can be casa

2. DO AN EXPERIMENT
Students must be aware that thmes shown in the booked sessions réfeMoodle server clock.
Thus, if a session staras 16:30 are 16:30 at the server time, not student computer. Also students must

15
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configure properly their timeone at their profiles. That is the reason why the server time is shown at
the plugin view.

Once the session starts the student must clickemdtivity link and he/she enters to the experiment
webpage directly.

On top the experiment there is a temporizer indicating the minutes left of the s&xsganthe
session expires the following message appears:

And the student is redirected teethooking sessions view:
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